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Using Adobe Photoshop 

6 – Layers 
One of the most useful features of applications like Photoshop is the ability 

to work with layers. Layers allow you to have several pieces of images in 

the same file, which can be arranged on top of each other to create a 

complete image. The following examples show the sort of things that can be 

done with layers in an image. 

Change the order of overlapping image elements 

 

Change the position of overlapping elements 

 

Blend image elements together in interesting ways 
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1 -  Creating Layers 

In Photoshop, you can create a new layer with nothing on it which can be used for editing. You 

can also create a new layer by either cutting or copying a selected section from an existing layer. 

Additionally, a new layer may already be created when you paste a copied section from another 

image or when you add additional image components such as text. The exercises which follow 

will use examples of some of these methods. 

Exercise 1 –  Creating new Layers from Selections 

1) Open Selections.psd. 

2) Select the upper rectangle in the image using any method learned previously. 

 

3) From the Layers menu select New and 

then Layer via Copy [Ctrl] [J]. 

 

 
Note This option can also be found by right-

clicking on the selected area and then 
selecting Layer via Copy. 

 

4) Select the circle shape using the elliptical marquee tool (remember you can hold down [Shift] 

to make the selection circle shaped and hold down [Alt] to select from the middle). 

5) From the Layers menu select New and then Layer via Cut [Shift] [Ctrl] [J]. 

 

A message like the one shown here will appear. You can’t select the circle because it is on a 

different layer. 

6) Click OK to close the message. 

7) View the Layers Palette (usually grouped with the Channels Palette). 
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You will see 2 layers. The top layer will be a new layer you have just created (most likely called 

Layer 1). The other one will be your Background layer. When you create a new image, it will 

usually have a background layer unless you created a new image with the transparent option. 

When a layer is selected it means that any edits or selections will affect that layer and not the 

other parts of the image. You can click on a layer to select it. 

 

8) Click on the Background layer to select it. 

9) Select the circle shape if it is not still selected. 

10) From the Layers menu select New and then Layer via Cut [Shift] [Ctrl] [J]. 

This time there shouldn’t be a problem since you’ve selected the layer that the circle is on. Look 

in the Layers Palette and there will now be three layers. Next to each layer you can see a small 

preview of the layer’s contents which helps you to know which layer is which. A good way to 

identify layers is by changing the properties of a layer. 

11) Double click on the name of the first layer (which should contain the rectangle). 

     

12) Type Rectangle as a new layer name and press [Enter]. 

13) Rename the second layer as Circle. You can also change the colour of a layer in the Layer 

Palette. 

14) Right click on the Rectangle layer and select a colour for the layer from the menu. 

 

15) Change the colour of the circle layer. 
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Exercise 2 –  Rearranging Layers 

One of the big benefits of layers is that it is easy to rearrange different parts of the image. 

1) Select the Rectangle layer in the Layers Palette. 

2) Temporarily select the move tool by holding down [Ctrl]. If that doesn’t work for some reason 

(it may not work when certain tools are selected, you can select the move tool by pressing [V] 

or by clicking the icon  in the Tools Palette. 

3) Move the rectangle to the right. You will see another rectangle underneath since we created 

the new layer by copying the selection. 

 

4) Select the Circle layer in the Layers Palette. 

5) Move the circle to the right. Since we created the circle layer by cutting, the area left behind 

by the circle will be filled with whatever your background colour is. 

 

6) Move the circle so that it overlaps the rectangle. 

 

The circle will cover the original rectangle that is a part of the background layer, but it will be 

covered by the new rectangle layer. The stacking order is determined by the order in the layers 

palette. 

7) In the layers palette, drag the circle layer so that it is above the rectangle layer. 

         

The circle will now cover both rectangles. 
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Exercise 3 –  Create more Layers 

1) Select the top car in the image using one of the methods learned in the previous section (Hint-

make sure you have the background layer selected first). 

 

2) From the Edit menu select Copy or press [Ctrl] [C]. 

3) From the Edit menu select Paste or press [Ctrl] [V] to paste the selection as a new layer. 

4) Rename the new layer as Car. You can change the layer colour if you want. 

 

To create a new blank layer you can go to the Layer menu and then select New and Layer, or press 

[Shift] [Ctrl] [N]. You can also click on the new layer icon at the bottom of the Layers Palette. 

 

 

5) Use one of the methods just described to create a new layer. 

6) Move the new layer below the Car layer and rename it Shadow (If you used the menu to 

create the layer you would have already been asked for the layer’s name). 
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7) Select the brush tool by pressing [B] or clicking . 

8) Set the brush options as follows. 

 Turn on the airbrush option -  

 Select a brush diameter of 30 pixels with a hardness of 0% 

 Set the flow to 2% 

 Change the foreground colour to black. You can do this quickly by choosing default 

colours with the icon  or by pressing [D]. 

9) Use the airbrush to gently shade in a shadow under the car. Because you are doing it on a layer 

under the car, it will be behind the car and won’t affect the car layer itself. Also, because it is 

on a different layer, if you don’t like the result it is easy to fix it without ruining the rest of 

your image. 

 

10) Save the changes to the image. 
 

Exercise 4 –  Showing and Hiding Layers 

Next to each layer in the Layers Palette is a small eye icon . This indicates whether or not a 

layer is visible.  

1) Click on the  icon next to the Rectangle layer to hide the 

contents of that layer. The rectangle in your image will disappear. 

2) Click the blank space next to the Rectangle layer where the eye 

icon used to be. This will unhide the layer and its contents will 

reappear. 

3) Hold down [Alt] and click on the hide icon  next to the Car layer. Every layer except the car 

layer will be hidden. The chequered squares indicate transparent areas of the image. 

 

4) Hold down [Alt] and click on the empty hide icon next to the Car layer again to re-display all 

of the hidden layers. 

5) Try hiding and displaying the Shadow layer and see the effect in the image. 
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2 -  Blending Layers 

Once you have an image with more than one layer, the layers can be blended together in a variety 

of ways. One way is to use modes. By default, a layer will block out any sections of layers that it 

covers. Blending modes allow you to combine layers in a variety of ways. Another way is to use 

layer transparency settings to simply make a layer partially transparent. A layer mask can also be 

used to hide parts of a layer a bit more selectively.  

Exercise 5 –  Layer Blending Modes and Transparency 

1) Select the Circle layer. 

2) Locate the Opacity option on the layers palette. To use this option you can 

either click the arrow and drag the slider or you can enter amounts in the 

box. Higher amounts mean the layer will be more opaque. Lower amounts 

mean the layer will be more transparent. 

3) Adjust the Opacity to see how the Circle layer looks on different settings. 

 

100% opacity 

 

70% Opacity 

 

30% Opacity 

4) Select the Rectangle layer. 

5) Move the rectangle so that it overlaps the car (remember you can hold 

down [Ctrl] to temporarily access the move tool). 

The Modes options one of the first options you will find in the layers 

palette. Clicking on Normal will display a list of layer 

blending modes. These are exactly the same as the modes 

you used earlier with the painting tools. Selecting a mode 

will affect the way the layer will blend with layers that are 

beneath it. These layer blending modes are often used to 

create special visual effects in an image.  

6) Try some blending modes to see how the rectangle will blend with the car beneath it. 

 

Multiply mode 

 

Overlay mode 

 

Difference mode 

 

Color mode 
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Exercise 6 –  Copying a layer to another image 

1) Select the Car layer. 

2) Press [Ctrl] [A] to select all pixels on the car layer. Although it might look like the whole image 

is selected, areas of the layer where there are no pixels will not have anything selected. 

3) Press [Ctrl] [C] to copy the selected pixels. 

 
Note Pasting now would create a new copy of the layer in the current image but we will paste it in to a 

new image instead. 

 

4) Create a new image by selecting File and New or by pressing [Ctrl] [N]. Notice that the Preset 

option is set to Clipboard. The width and height of the new image will be automatically set to 

the dimensions of what you have copied. A handy feature!  

 

5) Click OK to create the blank image and then press [Ctrl] [V] the paste what you had copied. The 

new image will now have a layer with the car image (which will probably be called Layer 1). 

There are other convenient ways to copy a layer to another image. If both images are visible you 

can simply use the move tool to drag a selection from one image to another as shown below. You 

can make both available by going to the Windows menu, then selecting Arrange followed by an 

option which allows for the viewing of more than one image at a time such as Tile or Float. 
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If you have both images showing, you can also drag the layer’s name from the layers palette to the 

new image. The benefit of this method is that the whole layer will be copied along with the layer 

name. 

 

With either of these two methods, it is useful to hold down the [Shift] 

key as you drag the selection / layer to the new image. This will 

mean that the copied selection or layer will be placed exactly in the 

centre of the new destination image. 

6) Switch to the Selections image. 

7) With the new image selected, delete the new layer by dragging it 

to the delete layer icon at the bottom of the layers palette. 

8) Move your mouse over the Car layer in the Selections image. 

9) Hold down [Shift] and drag the layer to the new image. The layer 

will be copied to the new image and will retain the layer name. 

Any additional information about the layer such as opacity, 

blending modes and layer effects (explained later) are also copied. 

 

 

 



Using Adobe Photoshop CS6  Layers 

© Steve O’Neil 2012 Page 10 of 16 http://www.oneil.com.au/pc/ 

 

Exercise 7 –  Using a layer mask 

1) Make sure you have the new image with the car layer selected. 

2) Create a layer mask by clicking the Add Layer Mask icon  at the bottom of the layers palette. 

A layer mask thumbnail will appear next to the layer thumbnail in the 

layer palette. It will be all white indicating that the entire layer is 

currently visible. A layer mask is very similar to a selection mask. With a layer mask, you paint 

over areas with black that you want to be hidden. Painting over hidden areas with white will make 

them visible again. Painting over areas with any other colour will make them partially visible. The 

layer mask thumbnail will show the hidden areas of the image. The main benefit of a layer mask 

is that it allows you to hide parts of a layer without actually deleting pixels. Time to test it out. 

3) Press [D] to set your foreground and background colours to the default colours. Normally 

black will be the default foreground colour with white as the background but the reverse is 

true with a layer mask. Press [X] to swap the colours so that black is the foreground colour. 

4) Press [B] to select the brush tool. Select a brush size that is big enough to see clearly so you 

can see the effect on the layer mask. Make sure the Mode is set to normal and Airbrush off, 

with Opacity and Flow set to 100. 

Before painting on a layer mask it is important to make sure you actually have the layer mask 

selected, otherwise you might end up painting a black streak across your layer. If the layer mask is 

selected, it will have a thick line around the layer mask thumbnail. Otherwise the layer thumbnail 

will have the line around it. If in doubt it doesn’t hurt to click on the layer mask thumbnail before 

painting on the mask.  

 Layer selected 

 Layer mask selected 

5) Make sure you have the layer mask selected and paint a line across the car. The area you paint 

across will become transparent. 

6) Paint some more lines across the car to make more areas 

transparent. The transparent areas will be shown as black areas on the layer mask thumbnail. 

7) Press [X] the swap the colours so that white becomes the foreground colour. 

8) Paint across the lines you have created. Transparent areas you paint across with white will 

become visible again. 

9) Make black the foreground colour again. Set the brush Opacity to 50%. Paint over the car and 

the affected areas will become partially transparent. 

10) Press [D] to set default colours again (white will be the foreground). 

11) Press [Alt] [Delete] to fill with the foreground colour (white) and make the whole layer visible 

again. 

12) Press [G] to select gradient tool. 

13) Drag across the image to create a 

gradient that will change from 

transparent to opaque. 

14) Hide the background layer. The 

transparent areas will show a checker 

pattern. 

15) Close the new image without saving it. 
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Exercise 8 –  Using Layer Effects 

Photoshop has many built in effects that can be applied to a layer. These include effects such as 

shadows, gradients and bevels. If a layer effect is applied to a layer, the effect will update if the 

contents of the layer change. Several layer effects can be combined to create some very interesting 

looking visual effects. 

1) Make sure your Selections image is still open. 

2) Use what you have learned in this section to create a new layer copy based on the 

star shape. Call the new layer Star. 

3) Click the Add a layer style icon  at the bottom of the layers 

palette. 

4) Select Bevel and Emboss from the list of layer styles. A dialog 

like the one shown below will appear. 

 

 

You will notice that the layer itself will automatically be changed by the layer effect options. This 

means that you can experiment with the layer effect options and see the effect immediately. 

5) Try some of the different Style options and then change the style back to Inner Bevel. 

6) Try adjusting the Depth, Direction, Size and Soften options until you like the result. 

7) Drag your mouse around the Angle preview to adjust the light direction. 

8) Adjust the options until your star looks similar to the one below. 

It is possible to apply more than one layer effect at the same time, simply by ticking 

each effect you want from the list on the left and then modifying the options for each 

effect to suit your needs. 

9) Tick the Drop Shadow option to add that layer effect. 

10) Click on the name of the Drop Shadow effect to display its options. 

11) Experiment with some of the drop shadow effect options. 

12) Click OK to apply the layer effects and save the changes to the Selections file. 
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Exercise 9 –  Putting it all together 

See how good you are at working with layers by completing the following. 

1) Open the files Portrait.psd (which should have your saved selection from an earlier section) 

and Park.jpg. 

 

Portrait.psd 

 

Park.jpg 

We are going to copy the boy from the Portrait picture in to the foreground of the park picture. 

2) Make sure the Portrait image is selected. If your images are in the tabbed layout then make 

sure you click the File tab for the Portrait picture. 

 

3) The tabbed view allows us to switch between open pictures while viewing one at a time. Since 

we’ll be working with more than one picture here it can be useful to have them both showing. 

From the Window menu select Arrange. Then select one of the options that allows for viewing 

more than one image at a time such as Tile or Float All in Windows. In the following exampled 

the Tile option has been used. 

4) Display the channels palette. Your saved selection should 

be at the bottom of the channels list (if it’s not then bad 

news – you’ll have to select it all over again). 

5) Hold down [Ctrl] and click on the Outline channel to 

quickly activate the selection. 

 
Tip You can also hold down control and click a layer in the 

Layers palette to make a selection based on the content of 
that layer. 

 

6) Hold down [Ctrl] to temporarily 

activate the move tool since we 

will be moving (copying actually) 

the selected area to the park 

image. 

7) With the move tool still selected 

drag the selection to the other 

image (You can hold down [Shift] 

as well if you want the selection 

to be placed in the middle of the 

other image, but we’re going to 

move it around once it’s there 

anyway so it’s not so important). 
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8) Once the selection is copied, you can close the Portrait image since it’s no longer needed. 

9) The boy will now be a new layer in the Park image. Rename the new layer as Boy (If you still 

have the Channels palette showing you will need to switch to the Layers palette). 

10) Press [Ctrl] [T] to activate Free Transform. Move and resize the boy so that the size and 

positioning are similar to the example below When you are re-sizing make sure you are 

dragging a corner and holding down [Shift] so the height and width stay in proportion. Press 

[Enter] when your size and positioning are about right. 

 

11) If your original selection was a bit rough, you may have extra bits around the boy that don’t 

belong. Now is a good time to apply a layer mask and then use an appropriate brush to neaten 

up the edges. 

12) Save the image as Park.psd. 

You might like to practice this by placing a picture of yourself in another image. 
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3 -  Shortcuts Learned 

Shortcut Icon Purpose 

[Ctrl] [J]  New layer via copy 

[Shift] [Ctrl] [J]  New layer via cut 

[Shift] [Ctrl] [N]  New layer 

 
Tip In an image with a lot of layers, you can organise them by grouping related layers in to sets. The 

Create a new set icon  lets you create a new folder set. You can then move layers in to that set. 
This allows you to not only be more organised, but to apply certain changes to the grouped layers 
all at once. Layer sets can be moved and edited in other ways together. Layer groups can also be 
collapsed to save room in the layers palette as shown below. 
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4 -  Blending Modes 

The following descriptions of blending modes are taken from Photoshop’s online help. 

Normal 

Edits or paints each pixel to make it the result color. This is the default mode. (Normal mode is 

called Threshold when you're working with a bitmapped or indexed-color image.) 

Dissolve 

Edits or paints each pixel to make it the result color. However, the result color is a random 

replacement of the pixels with the base color or the blend color, depending on the opacity at any 

pixel location.  

Darken 

Looks at the color information in each channel and selects the base or blend color--whichever is 

darker--as the result color. Pixels lighter than the blend color are replaced, and pixels darker than 

the blend color do not change.  

Multiply 

Looks at the color information in each channel and multiplies the base color by the blend color. 

The result color is always a darker color. Multiplying any color with black produces black. 

Multiplying any color with white leaves the color unchanged. When you're painting with a color 

other than black or white, successive strokes with a painting tool produce progressively darker 

colors. The effect is similar to drawing on the image with multiple magic markers.  

Color Burn 

Looks at the color information in each channel and darkens the base color to reflect the blend 

color by increasing the contrast. Blending with white produces no change. 

Linear Burn 

Looks at the color information in each channel and darkens the base color to reflect the blend 

color by decreasing the brightness. Blending with white produces no change. 

Lighten 

Looks at the color information in each channel and selects the base or blend color--whichever is 

lighter--as the result color. Pixels darker than the blend color are replaced, and pixels lighter than 

the blend color do not change.  

Screen 

Looks at each channel's color information and multiplies the inverse of the blend and base colors. 

The result color is always a lighter color. Screening with black leaves the color unchanged. 

Screening with white produces white. The effect is similar to projecting multiple photographic 

slides on top of each other.  

Color Dodge 

Looks at the color information in each channel and brightens the base color to reflect the blend 

color by decreasing the contrast. Blending with black produces no change. 

Linear Dodge 

Looks at the color information in each channel and brightens the base color to reflect the blend 

color by increasing the brightness. Blending with black produces no change. 

Overlay 

Multiplies or screens the colors, depending on the base color. Patterns or colors overlay the 

existing pixels while preserving the highlights and shadows of the base color. The base color is 

not replaced but is mixed with the blend color to reflect the lightness or darkness of the original 

color.  

Soft Light 

Darkens or lightens the colors, depending on the blend color. The effect is similar to shining a 

diffused spotlight on the image.  

If the blend color (light source) is lighter than 50% gray, the image is lightened as if it were 

dodged. If the blend color is darker than 50% gray, the image is darkened as if it were burned in. 



Using Adobe Photoshop CS6  Layers 

© Steve O’Neil 2012 Page 16 of 16 http://www.oneil.com.au/pc/ 

Painting with pure black or white produces a distinctly darker or lighter area but does not result in 

pure black or white.  

Hard Light 

Multiplies or screens the colors, depending on the blend color. The effect is similar to shining a 

harsh spotlight on the image.  

If the blend color (light source) is lighter than 50% gray, the image is lightened, as if it were 

screened. This is useful for adding highlights to an image. If the blend color is darker than 50% 

gray, the image is darkened, as if it were multiplied. This is useful for adding shadows to an 

image. Painting with pure black or white results in pure black or white. 

Vivid Light 

Burns or dodges the colors by increasing or decreasing the contrast, depending on the blend color. 

If the blend color (light source) is lighter than 50% gray, the image is lightened by decreasing the 

contrast. If the blend color is darker than 50% gray, the image is darkened by increasing the 

contrast.  

Linear Light 

Burns or dodges the colors by decreasing or increasing the brightness, depending on the blend 

color. If the blend color (light source) is lighter than 50% gray, the image is lightened by 

increasing the brightness. If the blend color is darker than 50% gray, the image is darkened by 

decreasing the brightness.  

Pin Light 

Replaces the colors, depending on the blend color. If the blend color (light source) is lighter than 

50% gray, pixels darker than the blend color are replaced, and pixels lighter than the blend color 

do not change. If the blend color is darker than 50% gray, pixels lighter than the blend color are 

replaced, and pixels darker than the blend color do not change. This is useful for adding special 

effects to an image. 

Difference 

Looks at the color information in each channel and subtracts either the blend color from the base 

color or the base color from the blend color, depending on which has the greater brightness value. 

Blending with white inverts the base color values; blending with black produces no change. 

Exclusion 

Creates an effect similar to but lower in contrast than the Difference mode. Blending with white 

inverts the base color values. Blending with black produces no change. 

Hue 

Creates a result color with the luminance and saturation of the base color and the hue of the blend 

color.  

Saturation 

Creates a result color with the luminance and hue of the base color and the saturation of the blend 

color. Painting with this mode in an area with no (0) saturation (gray) causes no change.  

Color 

Creates a result color with the luminance of the base color and the hue and saturation of the blend 

color. This preserves the gray levels in the image and is useful for coloring monochrome images 

and for tinting color images. 

Luminosity 

Creates a result color with the hue and saturation of the base color and the luminance of the blend 

color. This mode creates an inverse effect from that of the Color mode. 

 


